MISSION RDITOR

This Mission Editor tool is a slightly modified version of the actual tool used by NovalLogic Mission Designers. Although
some of the campaign programming has been disabled, you will find this tool extremely flexible when it comes to design-
ing your own missions. This manual will only cover the basic requirements for successfully creating a mission. Because
mission design has so many complex components, this tool is intended for the advanced user.

Use at your own risk.
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The Mission Editor Tool requires a minimum screen resolution of 800x600. For best results, we recommend that you set
your resolution to at least 1024x768. It is also recommended that you have at least 160 megs of memory free when using
the tool.



Section 1: Navigating the Tool

There are a number of keyboard controls and toolbar buttons that will help to create missions more efficiently.

Mouse Commands:

Left Button — Selects or unselects an item in Select Mode or Inserts a new item in Insert Mode. You can left click on the
Unselect All button or you can hit the U key to unselect all selected items. You can select more than 1 item at a time. As you
select items the attributes of the most recently selected item will appear in the lower left side window in the tool. While an
item is selected you can left click on the Selected Information Box in the left corner to pull up the ltem Attributes window.
Left Button with SHIFT held down — Selects everything within the box you create.

Left Button with CONTROL held down — Unselects everything within the box you create.

Right Button — Brings up a menu for copying, pasting and selecting.

Right Button with SHIFT held down — Click and move right or left to quickly zoom in and out of the map.

Right Button with CONTROL held down — Centers the map at the point you clicked on

Keyboard Commands:

Keypad 2,4,6,8 - Scrolls map down, left, right and up respectively.

Page Up, Keypad 9, Keypad Plus - Zooms map in.

Page Down, Keypad 3, Keypad Minus - Zooms map out.

INSERT - Toggles between Insert Mode and Select Mode.

DELETE - Delete selected items.

ALT - Hold to use hotkey listed in the toolbar menu. For example, pressing ALT + E pulls down the Edit Menu. After that,
pressing ALT + | will open the General Information window.

ARROW KEYS - Move the objects you currently have selected in very small increments. Using Control + Arrow keys will move
objects in greater increments.

U - Unselects all selected items
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Screen Buttons:

[c ul|bp

[P1 P2 | [x:-240.507656, v: 548.964844 m)

Layers Unselect All

G — Character Map — Press this button or the F1 key to show a full color representation of the terrain.

H — Height Map — This button and the F2 key will bring up a topographical view of the terrain where the lighter the color the
higher that part of the terrain. Solid dark areas are usually low, flat spots which is good for bases or airfields.

D — Depth Map — This view simply shows the contour map of the terrain. The closer the lines are to each other, the steeper
the grade. Solid black represents perfectly flat areas. You can also use the F3 key to see this map.

P1 — Page 1 — The Delta Force: Land Warrior Mission Tool allows you to have two different missions open simultaneously.
This feature is good for comparing missions or for copying/pasting elements out of one mission into another.

P2 — Page 2 - Press this button to display the second mission that you opened. Note you must be on this page when you open
the second mission or it will replace your page 1 mission.

XY Coordinates — This gives you the grid location of the center of your screen. Click on this to type in new coordinates and
the screen will center on them. The units are in meters.

Layers — This option brings up a box that allows you to select which layers you would like to see and which ones are hidden.
See Section 4 for more information on Layers.

Unselect All — This button (or the U key) will automatically unselect all items.
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Grid — Items that you insert while the Snap box is checked will move to the nearest grid
intersection. This is particularly useful when you want to line items up precisely. The View
box will toggle the grid overlay on and off. Use the Plus and Minus symbols to increase and
decrease the grid resolution (size).

Show — By checking the appropriate boxes, you can choose which items you see and
which are hidden from view. This is useful for finding specific items in a map full of various
item types.

Selected Information Box — When you select an item, its most important statistics appear
in the lower left corner of the screen. Click anywhere in this area to bring up the ltem
Attributes window.

The red box on the terrain map displays the maximum size of the terrain. Any items you
place outside the red box will be forced to the inside edge of the red box when you export
that mission. The green box shows you the suggested area in which to make your mission.
Placing items outside of the green box may make the mission excessively long.
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Section 2: Creating a New Mission

This section outlines the minimum amount you have to do to start making a mission for Delta Force Land Warrior. Refer to
Appendix C to see an example of a simple mission.

Step 1: Start the DFLWMed.exe program. You can find it in your Delta Force Land Warrior folder.

Step 2: Select General Information from the Edit menu at the top of the screen.

Step 3: Make up a name for your mission and type it in the Mission Name box. (Example “The Longest Road”)
Step 4: Select a Mission Terrain and Mission Type from the list and click “OK”.

Step 5: Press the Insert key to enter Insert Mode, select a location for the player to start and left click the mouse.

Step 6: In the Insert Item window, select “Markers” in the left hand column, then “Start, Player” in the right hand column, then
click “OK”.

Step 7: Press the Insert key again to change back to Select Mode and use the left mouse button to select the “Start, Player” icon.
Now click anywhere in the Selection Information Box on the lower left of the screen. This will bring up the Item Attributes window.

Step 8: Change the Al Variable Group to “1 - Blue Players” and change the Team to “Good (Blue)” then click “OK”.
Step 9: Go to the File menu and select Save to save your mission.
Step 10: Although you could export and play your mission at this point, it probably wouldn’t be very interesting. You are now ready

to begin placing enemies, setting mission events and determining mission goals. As you place them refer to the appropriate section
of this manual for more details.

Don’t forget to save your work often. Mission Designers will typically keep several back-ups of the files just in case they
make mistakes on their current file.
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Section 3: Editing

Mission Briefings

Under Edit in the Tool Bar, select General Information to set the basic mission details. Select Briefings to edit the text that
players will see on the mission briefing screen before the mission begins.

General Information &

Mission Name — This is the unique name that people will see when selecting your mission.

Mission Designer — Put your name here.

Map Types
[V Cooperative

™ Deathmatch
™ Team Deathmatch

Tenain Overnides

™ King of the Hil
I Team King of the Hil

I™ Capture the Flag

I™ Attack and Defend
I~ Ssaich and Destiay

I Flagbal

Sky Setlings

‘Weather

NiceDay -
Diay5 - Dull Light Blue -

Night
jsc
Fire Missians Avalable
wind

Spesd [kph

Direction

¥ iater Level 126 r
I™ FogLevel 0
I Fog Color
Sun
i 0 o
Default Equipment
For Character L
Grenadier, Gias Can -
Win Conditians
Primary [Fontact rangers st Dbisctive Grave =]
AR - MA Master Key” = [Escont 1angers to E raction Point, |
Secandary o =
M - Calcn - [
Sideam ] =
P -5SOCOM 45 -
— Lose Conditions
T4 Shouder Frociat — [P rangens are Killed k3|
rFem [ -]
[Double Ammo Load | [h4wil =]
[ 3|

3

17

Mission Terrain — Consult with Appendix A for a list of all
terrain available and select the one that best fits the location
of your mission.

Item Colors - ltems choose from 3 different camouflage
styles: Green (for grassy terrain), Brown (for desert terrain), or
White (for snow terrain). Choose the one most appropriate for
your mission. All items with multiple camo settings will use
the one color selected here when the mission is exported.

Default Equipment — Select the gear that is most appropriate
for the player (by character type) in your mission. The player
will be able to change this gear before entering the mission or
at an armory if one is available.

Primary Teammate - This is the character that will be used if
you place a teammate on the map.

Secondary Teammate - If the player chooses to be the same character as your primary teammate, this indicates the character the
teammate will change to.

Map Type — Select what type of mission you are making. For single player missions, select “Cooperative”.

Terrain Overrides — You can raise the water level in your mission (measured in /2 meters). We recommend that you do not go

over 130 for most maps or the entire mission may take place underwater. If you want fog in the mission, select its level here (1-7).
0 is off, 7 is extremely thick and 1 is so thin it appears as an overcast day. Between 4 and 5 is best for missions with fog. You can
also alter the color of the fog by manually setting the Red, Green and Blue settings. Fog is best when Gray (50,50,50). Other exam-

ples of colors:

Bright Red = 255,0,0
Medium Green = 0,120,0
Dark Blue = 0,0,25

Yellow = 0,100,100

Black = 0,0,0

White = 255,255,255

Sky Settings — With these settings, you can add weather effects such as rain or snow and set the position and brightness of the
sun or create a night mission. Be sure to check the Night box in addition to selecting a night sky, as this will properly adjust cer-

tain art elements.

Win and Lose Conditions — You can set up to four win or lose mission goals in this area. The win and lose conditions are for goal
information text only. The actual win and lose conditions are set up through the events (see page 10).

Fire Missions Available — Indicates the number of artillery support strikes the player can call with the laser designator.

Wind Settings — If you want wind to play a part in your mission, set the wind speed and direction here.
Light Wind = 25 kph, Heavy Wind = 50 kph, Hurricane Wind = 90 kph
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Section 4: Groups and Layers

The most important part of building a good mission is organization. You can quickly get lost in a sea of meaningless numbers
unless you take the time to properly label things. A little work in the beginning saves a lot of headaches later on.

Groups

Groups are used to classify related items such as a
squad of enemy soldiers and set an identity for Events
and Waypoints. It is often better to give each unit its
own orders so that it doesn’t interfere with other units.
However, placing multiple units in a group may save
you time setting up the mission. You can rename

the group to any name you want and automatically
select all units within a group from the Group window,
under Edit. Click Print List to save the list to a text file
for printing.
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Layers

Layers are vital to sorting out all of the items within a mission.
You can create up to 32 individual layers for sorting. Under
the Edit menu, you can change the Layer Names to whatever
has meaning to you. Some examples of names are Enemy
Base, Friendly Waypoints, and Foliage. When you just want to
see a certain layer of items, hit the Layers button on the main
screen and check the ones you want to see.
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Section 5: Waypoints

Waypoint groups tell vehicles and soldiers where to go. Set up
Waypoints under the Edit menu. Again you can name a waypoint e A S

group with whatever name you chose. The Waypoint window will Pt e Sessttztan

show you how many individual waypoints are part of a waypoint 2 B ot [Fecure langer

group. If you check the “Waypoint does not loop” checkbox, then the éEEE g -
vehicle will come to a stop at its last waypoint. Otherwise vehicles W ont _

reaching their last waypoint will attempt to head back to their first 13- F Fangers " Waspant dees AT oop

waypoint and start again. You place waypoints (found under Markers | |is-Fiserviapont: M G

in the Insert Item window), as you would insert other objects. Click | [17 Rerrcico ™ RedTean weypoit

Print List to save the list to a text file for printing. 13 Ereclon Sl — ‘ m

Placing Waypoints

A waypoint is designated by 2 numbers, such as waypoint 1-1 or 2-4. The number before the dash indicates its Waypoint List
number. The number after the dash indicates its Waypoint Number. Waypoints are numbered from 0 up, not 1 up. The

“reached waypoint” triggers follow this logic. So to the trigger, the second waypoint in a list is “1” no matter what they numbered
the object as.

Setting up a waypoint list:

1.

o

NG

11.
12.

13.
14.
15.
16.
17.
18.
19.
20.
21.

Go to Edit in the menu and then select Waypoints

Select waypoint list 2. Click in the Description box and type “Enemy’s Waypoints”

Below that is a box to select a color for the lines connecting the waypoints. Select a color if you feel like it.
Below the Golor box is a small check box. This determines whether or not your waypoint list will loop.
We don’t want our first waypoint list to loop. Click on it so that it is checked, then click OK.

Go to Insert Mode by pressing the Insert key.

Click on the map somewhere near your enemy to add the first waypoint.

In the Insert ltem window, click on Markers then select waypoint.

Click somewhere else on the map to place your next waypoint.

Notice that Markers and waypoint are already selected. Just click on OK.

Repeat steps 8 and 9 a couple more times.

Get out of Insert Mode by pressing the Insert key.

Select all of the waypoints you just placed and then click on the Selection Information Box to bring
up the ltem Attributes window.

Change the Waypoint List box to “2 — Enemy’s Waypoints”. Click OK.

You should now see a series of connected lines. This is your waypoint list.

Unselect All with the U key.

Select your first waypoint and bring up the ltem Attributes window.

Change the Number attribute (located near the bottom of the window in the center) to “0”. Click OK.
Now unselect the waypoint and select another one. Change the number to “1”.

Repeat step 18, giving each waypoint a successive number.

Now your waypoints are numbered and ready to go. We just have one last thing to do.

Select the enemy unit and bring up the Item Attributes Window. Under the Waypoints section, Select List “2 - Enemy’s
Waypoints” like you did for the waypoints in Step 13. Click OK.
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Section 6: Inserting Items

After you have established some waygroups, you can begin placing items. ltems represent everything your player can encounter,
from enemy vehicles and buildings to scenery such as trees and water towers. While in Insert Mode, left click to set a new object
down. This will bring up the Insert Iltem window where you can select the type and sub-type of item that you want to place. Note
that Markers include Player/team start positions, waypoints, and King of the Hill areas.

After placing an item, switch back to Select Mode by pressing the INSERT key and left click on an item. The basic statistics of the
item will come up in the Selection Information Box. Click on this area to open up the ltem Attributes window.

While in the Item Attributes window, you can only alter attributes that pertain to the unit(s) selected. You will not necessarily need
to fill in every field available. Note that any attribute you modified will be changed for all items currently selected (where possible).

Social Serial Number (SSN): The tool automatically sets this
e * rrm - | number when an item is placed. It represents the item number
i aports — of the unit. Every unit has a SSN. The SSN is also used when you
e — are triggering actions to happen to or happen because of that
specific unit.
. Hul M T
B . Layer: All units belong to a layer. Selecting an appropriate layer will
e F || T leweras I Shong St Ty help you to better organize the mission. See Section 3 for more
Pitch (30 = up) T Weapon Ascuracy fion :: IDQ'::E Faihi :21:‘5‘1;;“““ |nf0rmat|0n on LayeI’S
Map Symbol Fsizeation [0 I Bind T Cowaid . L. . .
o I~ sterig r Position: This is the precise coordinates of where you placed the
R;WDL::'W... NPC Primary Weapon 'l::::::Lell unlt on the map
I P e — R East = -X, West = X, North =Y, South = -Y
= B Above Ground/Sea Level = Z, Below Ground/Sea Level = -Z
i Be sure to properly set the Height (Z value) if you want to put objects
on top of other objects (like soldiers in towers). You will likely need
to adjust the second Z number to precisely place objects on tables
and crates.

Absolute Height: With Absolute Height on, the Z value indicates height above sea level. With Absolute Height off, the Z value
indicates height above or below the actual terrain at that spot.

Facing: This is used to change the direction an item is facing. It can be set from 0 to 360 degrees, with 0 representing North, 90
representing East, 180 representing South and 270 representing West. Pitch is the degree the object is pitched forward or
backwards; something pitched at 90 will be pointed straight up rather than forward.

Map Symbol: If you want the item to show up on the player briefing map and Commander’s Map, select the appropriate icon here.

Remove if: This is used when changing the difficulty of a mission for multiple players. For example: If a 4 is placed in the Remove
If Less Than... field, that particular unit would only appear in that mission if more than four player were in the multiplayer game.

Sub-type: This designates what the object is. If you change the sub-type to a different object, the attributes you set for the initial
object sub-type will be retained.

Group: All Squads and Air Support are in groups. You can name groups whatever you want by clicking on Edit in the top left corner
of the tool and then clicking on Group.

Team: This designates good guys, bad guys and neutral guys. Red will target/attack blue and vice-versa whether marked goals or
not. Neither blue nor red will target a neutral item.

Name: This name shows up if you select the unit on the commander’s map, if the person with the name is blue team. This will also
show when you point at the unit or show friendly tags if they are on your team.

Field of View: This tells you the extent that people and vehicles can see around them. 10 degrees would be like someone with
tunnel vision. A soldier with 360 degree FOV would have eyes in back of his head.
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Weapon Accuracy: This number represents how well the unit shoots. Lousy shots are 10 and under, good shots are around 30,
great shots are anything over 50. However, anyone will hit fairly quickly at close range. Also, the longer someone continuously fires
at a target, the more accurate they will get.

Perception: This is a rating of how well the Al can see, 30 is near sighted, 50 will notice most stuff at short ranges, 80 will notice
you across a valley.

NPG Primary Weapon: If the Al unit can hold a weapon, this is where you assign the type.
Grenades: Select the number of grenades the unit will carry.

Waypoint list: This is where you assign groups to waypoints. You can name and organize waypoint lists the same as groups (Left
click on Edit and Waypoints). The number field is used to number waypoints. For King of the Hill Centers adjust the Distance to
increase the size of the hot zone.

Al Attributes: You can assign several different attributes to people or vehicles.

Ignore Gunshots: The unit won't react to nearby gunshots.
Ignore Yells: The unit won’t react to nearby yelling.

Ignore Footsteps: The unit won’t react to nearby footsteps.
Deaf: The unit won’t hear enemies.

Blind: The unit won’t see enemies. Deaf and Blind are good for keeping hostages from running away from firefights or keeping a
blackhawk from engaging enemies as it flies overhead.

Standing: When at Red Alert, the unit will not drop to a crouched position to fire. Good for units standing behind bunkers.
Prone: When at Red Alert, the unit will drop to a prone position. Good for snipers.

Break Left: When at Red Alert, the unit will head to its left unless it has specific waypoint instructions.

Break Right: When at Red Alert, the unit will head to its right unless it has specific waypoint instructions.

Guarding: Unit will stay at its position. Good for units in towers.

Strong Silent Type: This unit will not yell for help.

Afraid To Swim: This unit will only enter water up to a certain point.

Rolls Over: When prone, the unit will periodically roll over.

Coward: When the player gets within a certain distance, this unit will cower and surrender.

Hovering: Used for helicopters to put them into the air.
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Section 7: Area Triggers and Events

Area Triggers
Area Triggers are rectangular areas that can be used to trigger actions whenever a member of a Group is within its borders.

Area Triggers are set like waypoints, except you must set two of them to the same Area Trigger number; this will form a rectangle
around the area. See Events below for more information about Triggers.

BEvents

One of the most complex and powerful parts of the mission editing is creating events. With this tool, you will be able to set up a
series of actions that only occur when certain conditions are triggered. Each event is set up as an IF-THEN statement; in other
words IF a condition is met by the game, THEN the event takes place.

Here is an example of how to set up a win condition for Delta Force: Land Warrior. Say you wanted the player to win the game if
they destroy a certain building:

1. While in Insert Mode, place a building on the map then return to SELECT MODE.

Return to Select Mode and select the building.

Right click the building with the mouse and click on Edit Item Attributes. Select a unique
Group Number under Al Variables.

4. Open the Events window and click on << New Trigger >> to open the Event Triggers window.
5. Select Group for the Trigger Type.

6. Select All Destroyed for Trigger Gondition.

7. Under Trigger Variables select the building’s group # that you just placed then hit OK.

8

9

1

LN

Now click on << New Action >> to open the Event Actions window.
. Select Blue Win for the Action Type.
0. Finally, for ease of identifying it, give the event a unique name at the top of the window such as “Win by destroying building”.

Reset after (seconds): Once this event has been == oo
triggered, the mission can be set to automatically
. g [~ Reset after [seconds)
reset the trigger after a specified number of seconds :
has elapsed. Deylsscondsl [
[0] Plaver rescues Hanger [group B] \F[[D']fgggersi T T
Delay (seconds): This is how many seconds must pass %ﬁ E::ﬂi’%@é“;?éﬁ:f:::wk] e Mo o e
before the actions will execute. 0 delay means that the {4 s Fai
. - . - layer rescues rangers [redirect [eammate Coy
actions will be carried out as soon as the trigger | b B J”
conditions are met. (o cpmae eaches end ol 1t v
H 10% ;mup 14t1 5 n;ngels dead J
[12) Other rangers kiled
. } ) [13] Single Player enter THEN [ Astions )
See Appendix B for a complete list of Triggers ﬁgi E‘:ﬁ;;::i?ﬁ:iL:;Eifﬂzﬁ‘;:";iﬁ‘:nsgilz e oo S0 warar
and Actions. [17) Rargets o028 waterlgnets gunshets 3 B o 1 Delete
(15 Rarrscros o orove ooty 5 (1 et v 1210 ot 16
=3
[23) Delay D!a\ug
Lidkl&:zcé::ﬂn)v; destrayed
Delete Event Copy Event Print Event Print &1l Events ‘ QK
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Section 8: Exporting and Playing Missions

Remember to Save your work often. When you are at a point where you would like to test your mission, go to Export Binary
Mission under the File menu. Your custom mission (.BMS file) must be located in the same directory as your Delta Force: Land
Warrior game for it to be seen by the program.

You are limited to the number of different types of items you can have in one mission. When you export, the tool will indicate if you
have too many different items.

The following Warnings can show up when exporting the file:

e The total number of Decorations and Buildings (X) exceeds the maximum (1024)

e The total number of Vehicles and Objects (X) exceeds the maximum (1024)

e The total number of Markers (X) exceeds the maximum (512)

e The total number of People (X) exceeds the maximum (256)

The file will still export, but only the first Y objects of that type will be exported (Y being the maximum number allowed for each
category). The number of objects should be reduced to the limit or unpredictable things could happen as a result of the excess

items not being exported.

To play your custom mission, start your Delta Force: Land Warrior game. In Quick Mission or Multiplayer Hosting Screen, select
your mission from the list of games.

Mission Editor Manual P11



Section 9: Hints and Tips

e For your first mission, open the sample.mis mission and begin tweaking aspects of it. This mission was created to give you a
head start on creating a mission. Looking at how a mission designer lays things out may help you understand specific
portions of a working mission.

e For ease in viewing units, use the Height Map view (F2 key). The items will stand out more against this background.

e Using the layering functions can help save a lot of time when fine tuning missions. Putting items in Layers may seem like a
hassle for smaller missions, but when more and more items are added, you will really wish that you had done it.

e When you right click the mouse with no items selected, you can choose to View by Side; this will turn all of the bad guy’s
items red, all of the good guy’s items blue and all of the neutral items green for ease of game balancing.

e The best method for laying down waypoints is to insert one, change to select mode, set its waylist group, and change its
distance to O (this causes people to follow the path exactly). Then copy that waypoint and paste it where you want the next to
be. Since the freshly pasted waypoint is already selected, just input its waypoint number, then paste the next and repeat.

e When placing buildings, use the F3 view to find a good flat spot.

e In Capture the Flag missions, it's a good idea to drop a “null” marker on top of any flag you put down, then set the null
marker to the team color of the flag. This allows you to see your flags from a zoomed out perspective, where they’d normally
be hard to see.

e A good rule of thumb for placing objects is whenever you want to place an object which has others like it already in the
mission, it’s simpler to copy and paste it, then modify the new one (rather than switch to insert mode and create a new one).

e Soldiers with “hip” in their name will fire from the hip rather than from the shoulder, and they may move towards their target
as they fire. Soldiers who shoot from the hip will not be effective if they are in bunkers or behind low walls. For best results,
place these units in open areas away from buildings.

e To have the player parachute into a mission, set the “Start, Player” marker’s Z value (height) to between 100.00 and 300.00.
This will also work with Al units.

e When moving vehicles, remember to set up an event with both “change group velocity” and “redirect group to waypoint”.
e You can rotate several objects at the same time by selecting them, right clicking and selecting “Group Rotate” from the list.

Save and export your mission often.
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Appendix A: Terrain Types

There is a pull down menu for your mission terrain. The letter indicates the terrain type (d=desert, g=grass, s-snow).
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Appendix B: Trigger List

"IF" Statements

Trigger Types

Null: Always False. Can be used as a temporary placeholder.

Group: Triggers affected by Groups. Needs a Trigger Condition (below).
Event: True if the Event has been triggered.

2ndTime: True if this is the even numbered time the mission is played.
SquadMates: True if Squad Mates are “on”.

Group Trigger Condition

Null: Nothing. Can be used as a temporary placeholder.

Has Targeted: True if Group X has targeted Group Y.

Condition Red: True if Group has been alerted of the enemy presence.
Condition Yellow: True if Group has been put on yellow alert.

All Destroyed: True if all members of the Group are killed/destroyed.
Any Alive: True if any members of the Group are still alive. This will trigger immediately unless other conditions are set.
Lost X Units: True if X number of units in Group have been Killed.
Reached Waypoint: True if Group reached waypoint.

Area Trigger: True if Group is within the Area Trigger.

Holds Item: True if Group is holding the specified item.

Has X Units: True if Group has X or more members alive.

Shot Enemy: True if Group X shot at and hit Group Y.
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"THEN" Statements

Action Types

Null: Always False. Can be used as a temporary placeholder.

Redirect Group To: Make Group go to Waypoint X-X.

Kill Group: Immediately kill all members of Group.

Change Group Al: Change an Al attribute of Group (See Al subtypes below) to “On” or “Off”.
Vaporize Group: Remove the Group from the game.

Blue Win: Blue wins!

Red Win: Red wins!

Group Velocity: Change the movement speed (KPH) for vehicles.

SubGoal Won: Sub Goal X has been achieved.

SubGoal Lost: Loss Condition X has occurred.

Change Team: Change the team of Group. This is useful for changing civilians to enemies if the player shoots them.

Action Subtype: AI

Null: Nothing. Can be used as a temporary placeholder.

New Weapon: Change the current weapon

Guard Bit: If he has waypoints, he will follow them and never stop to shoot at or follow an enemy unit. If he has no
waypoints, he will not move, but he will shoot at enemy units.
Stander: Will shoot while standing (default is to crouch and shoot).
Proner: Will shoot while prone (default is to crouch and shoot).
Red Alert: Be alert for enemies.

Yellow Alert: Heightened state of awareness.

GreenAlert: Everything’s clear.

Field Of View: Change the angle of Field of View.

Accuracy: Change the Accuracy level.

Perception: Change the Perception level.

Silent: Won't call for help (but may make noise while dying).
Blind: Doesn’t see anything.

No Water: Doesn’t go in water.

Rolls Over: Does roll over animation when prone.

Goward: Will surrender when player is in proximity.

Deaf: Doesn’t hear anything.

Deaf to Gunfire: Doesn’t hear nearby gunfire.

Deaf to Friendly Fire: Doesn’t hear yells of allies.

Deaf to Footsteps: Doesn’t hear nearby player footsteps.
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Appendix C: Sample mission

With the Delta Force Land Warrior Mission Editor open, select File, then Open, then select the “Sample.mis” file. This mission was
built for you to have a head start on designing a mission. You can also use it to deconstruct how a NovalLogic Mission Designer
builds a mission.

The tutorial terrain is in the desert during a dark, windy and rainy day.

A - The upper left side of the map shows the starting
position for the player, a teammate and black widow.
The blue lines are the player’s waypoints to the
enemy base.

B - The lower right side of the map shows the
enemy’s base and the red lines are the enemy
waypoints. In this mission two guards will patrol the
camp, while a third remains inside a building. Another
guard will be stationed up in a guard tower.

C - There is an additional patrol of 2 terrorists who
will only show up on a multiplayer game with 3 or
more players. Notice how the mission designer has
added the word “Ramped” to his Group labels to help
differentiate these objects from the objects that
appear in the single player game.

There are 5 events in this mission:

(0) 1st Goal Accomplished - If the player Kills all of the terrorists in the enemy base, then they have successfully completed the
first mission goal.

(1) Win Condition - If the base has been cleared (event 0) and the player reaches the extraction point, then they have successfully
completed the second goal and won the mission.

(2) Loss Condition - If Black Widow is destroyed (which is highly unlikely in this mission), then the mission immediately

ends in failure.

(3) Black Widow leaves Insertion - After the mission starts, Black Widow will wait 4 seconds, then head off to its waypoints
(ending up at the extraction point).

(4) Ramped patrol comes to defend camp- If there are 3 or more players and any of them enter the camp (marked off by area
triggers), then 2 more terrorists will become alert and head to the base.

Trying changing some variables of this mission, export it and play through it to see your changes. It will appear in the
Quick Mission list.
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